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改版履歴

版数 作成日 作成者 内容

1.0 2024年1月24日 プロメテック・ソフトウェア株式会社 新規作成

2.0 2024年3月7日 プロメテック・ソフトウェア株式会社 ファイルの変更履歴、USD Presenterの利用方法他を追記

2.1 2024年3月29日 プロメテック・ソフトウェア株式会社 大阪大学D3センター様ご指摘内容を反映

3.0 2025年1月20日 プロメテック・ソフトウェア株式会社
Omniverse USD Composer/ Presenter から Omniverse Kit Base Editor に変更
Nucleus バージョンアップに伴う変更を追記

3.1 2025年9月19日 プロメテック・ソフトウェア株式会社 Nucleusバージョンアップに伴う変更を追記

4.0 2026年3月31日 プロメテック・ソフトウェア株式会社 Omniverse Kit App TemplateでビルドしたUSD Composerなどの記載を追加
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- ハードウェア・ソフトウェア構成

• 主なOmniverseアプリケーション

- Kit Base Editor

- USD Composer

- ParaView Connector
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本書の内容について

• メタバース可視化システムの利用方法

- RTX GPU搭載Windowsワークステーションのリモートデスクトップ接続

- Nucleusへのアクセス方法

- ParaViewコネクタの利用方法

- USD Composer・Kit Base Editorの利用方法

- ONIONへのバックアップ

• Omniverse可視化ワークフロー例

- OpenFOAMのOmniverse可視化

- AVS/Expressの車両ハーフモデル（旧UCD形式）

- AVS/Expressのキャビテーション乱流（Field形式）

• Omniverseを活用した複数名でのコラボレーションのメリット
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はじめに

本書は2023年9月末に貴学に導入したメタバース可視化システムの利用者向けクイックスタートガイド

です。本書ではメタバース可視化システムのシステム概要、活用イメージ、利用方法について説明してい

ます。ただし、システム内のRTX WindowsワークステーションやNucleusサーバの接続先については本

書に記載していません。運用関係者にお問い合わせください。また、Omniverseの詳細は、NVIDIAが提

供するドキュメント（https://docs.nvidia.com/omniverse/index.html）を参照ください。

スライド左上のタグは対象者を記載しています。

運用者対象スライド

利用者対象スライド

運用者

利用者
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Omniverseプラットフォームの構成要素

運用者

利用者
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コンポーネント名 説明

NUCLEUS
Omniverseのコアとなるデータベースおよびコラボレー
ションエンジン

CONNECT
可視化コンテンツ作成ツールをOmniverseに接続するラ
イブラリ

KIT
Omniverseアプリ、拡張機能、マイクロサービスを構築
するためのツールキット

SIMULATION
物理的に正確な世界をシミュレートする強力なツール
とSDKのスイート

RTX RENDERER

NVIDIA RTXベースの高度なマルチGPUレンダラーでリア
ルタイムレイトレーシングモードとインタラクティブ
パストレーシングモードの両方をサポート

Omniverseは、次の5つのコア コンポーネントで構成されます。

メタバース可視化システムは、NUCLEUS を中心のデータベースとしたシステムであり、CONNECT としてParaView Connector、KIT とし
て Kit Base Editor を使うことができ、RTX RENDERER により、共同研究者間で強力でかつ高度な可視化コラボレーションを実現します。

Omniverseプラットフォームの構成要素

赤枠：メタバース可視化システムで利用が想定される主なコンポーネント

NVIDIAのWebページより

運用者

利用者

5



© Prometech Software, Inc.

メタバース可視化システム概要

運用者

利用者
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システム構成図
運用者

利用者
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学内ネットワーク

メタバース可視化システム

他大学GPU-WS

Omniverse connector

企業 GPU-WS

Omniverse connector

20GbE

学内GPU-WS 学内PC（GPU無）

Omniverse connector

学外ネットワーク

貴学ファイアウォール

Omniverse
Nucleus

基幹ネットワーク用スイッチ

10GbE

学内ネットワークスイッチ

USD

Nucleusサーバ RTX GPU搭載Windows
ワークステーション
（Blackwell）Omniverse connector

Omniverse Kit App Template
（Kit Base Editor & USD Composer）

Omniverse connector

RTX GPU搭載 Windows
ワークステーション
（Ada Lovelace）

利用方法１
RTX GPU搭載マシンから
Nucleusを利用

利用方法２
RTX GPU非搭載マシンから
RDP経由でNucleusを利用
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機種名 項目 詳細

HP Z8 G5 Workstation CPU Intel Xeon 6444（3.6 GHz/16 コア）

メモリ 128 GB

システム領域（HDD） 1 TB

データ領域（SSD） 2 TB HPZ Turbo（SSD） x 4 VROC RAID10

GPU T400

NIC 10 GbE NIC Dualport

モニター なし

その他 DVD内蔵/キーボード/マウス

保証 3年保証（オンサイト）
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ハードウェア構成（Nucleusサーバ）
運用者

利用者
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機種名 項目 詳細

HP Z8 Fury G5 Workstation CPU Intel Xeon W5-3435X（3.1 GHz/16 コア）

メモリ 128 GB

システム領域（SSD）C: 1 TB

データ領域（HDD）D: 4 TB

GPU RTX 6000 Ada x 1

NIC 10 GbE NIC Dualport

モニター なし

その他 DVD内蔵/キーボード/マウス

保証 3年保証（オンサイト、GPUのみセンドバック）

9

ハードウェア構成（RTX GPU搭載Windowsワークステーション（Ada Lovelace））運用者

利用者



© Prometech Software, Inc.

機種名 項目 詳細

HP Z8 Fury G5 Workstation CPU Intel Xeon W5-3535X（2.9 GHz/20 コア）

メモリ 256 GB

システム領域（SSD）C: 1 TB

データ領域（HDD）D: 4 TB

GPU RTX PRO 6000 Max-Q x 1

NIC 10 GbE NIC Dualport

モニター なし

その他 DVD内蔵/キーボード/マウス

保証 3年保証（センドバック）

10

ハードウェア構成（RTX GPU搭載Windowsワークステーション（Blackwell））運用者

利用者
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ソフトウェア構成
運用者

利用者
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種別 項目 ソフトウェア・バージョン

Nucleusサーバ

OS Ubuntu 22.04 LTS Server

NVIDIA Omniverse
Nucleus Enterprise 2023.2.9

Nucleus Tools 1.2.3

RTX GPU搭載Windowsワークス
テーション

OS Windows 11 Pro for Workstations

NVIDIA Omniverse
IT Managed Launcher 1.9.10 ※

各種アプリケーション（次スライド）

その他 ParaView 5.12.1・AWS CLI 2.33.28

ライセンス名称 ライセンス数 有効期限

NVIDIA Omniverse Enterprise Subscription per GPU 3サブスクリプション 2026年9月17日

NVIDIA Omniverse Enterprise Subscription per GPU 1サブスクリプション 2026年11月19日

〇 メタバース可視化システムのソフトウェア構成

〇 学内で利用可能なNVIDIA Omniverse Enterpriseライセンス（学外での利用は不可、別途購入が必要）

RTX GPU搭載Windowsワークステーション2台とNucleusサーバで計3サブスクリプション利用するため、
1サブスクリプションは学内向けの予備として利用することが可能です。

※ RTX GPU搭載Windowsワークステーション(Ada Lovelace)のみ
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Omniverseアプリケーション
運用者

利用者
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種別 項目 ソフトウェア・バージョン

RTX GPU搭載Windows
ワークステーション

(Ada Lovelace)

NVIDIA Omniverse
(Launcher) ※

USD Composer 2023.2.3 (Enterprise)

USD Composer 2023.2.5 (Enterprise)

Kit 106.0.2 (Release)

USD Presenter 2022.3.7 (Enterprise)

Cache 2023.2.6 (Enterprise)

Nucleus Navigator 3.3.4 (Enterprise)

Nucleus Navigator 3.4.0 (Enterprise)

Kitware ParaView 5.12 Omniverse Connector 201.0.1 (Release)

Omniverse Kit App 
Template

Kit Base Editor 106.4.0 (Windows版)

Kit Base Editor 108.0.0 (Windows版)

Kit Base Editor 109.0.3 (Windows版)

USD Composer

〇 利用可能なOmniverseアプリケーション

※NVIDIA Omniverse Launcherは2025年10月1日に廃止されました
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Omniverseアプリケーション
運用者

利用者
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種別 項目 ソフトウェア・バージョン

RTX GPU搭載Windows
ワークステーション

(Blackwell)

Omniverse Kit App 
Template

Kit Base Editor 108.1.0 (Windows版)

Kit Base Editor 109.0.0 (Windows版)

Kit Base Editor 109.0.3 (Windows版)

USD Composer

ParaView Connector単体 Kitware ParaView 5.12 Omniverse Connector 201.1.0

〇 利用可能なOmniverseアプリケーション
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主なOmniverseアプリケーション

運用者

利用者
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NVIDIA Omniverse Kit は、独自の3Dアプリケーションを構築するための強力なSDKツールです。

その核となるサンプルアプリ「Kit Base Editor」では、Omniverseの基本機能を体験できます。

Kit Base Editor
運用者

利用者
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✓ シーン構築：OpenUSD（Universal Scene Description）を用いたリアルタイムなシーン編集が可能。

✓ ビジュアライゼーション：高性能なRTXレンダリングによるフォトリアルな描画をインタラクティブに操作。

✓ SDKの導入：Kitの基本構造を理解するためのエントリーポイントとして最適。
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Kit App Templateを活用しビルドした「USD Composer」の利用を推奨します。大規模なワールド構築やライ

ティング、レイアウトなど、旧来のOmniverse Launcherで提供していたUSD Composer相当の機能が利用可能。

USD Composer (Kit App Template)（推奨）
運用者

利用者
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Paraviewのコネクタにより、ユーザーはParaviewがレンダリングしたものをすべてOmniverseに直接出力する

ことも、ローカルでUSDに出力することもできます。クライアント/サーバーモード、pvpythonベースのワークフ

ロー、ヘッドレス環境、およびマルチノード構成をサポートしています。

ParaView Connector
運用者

利用者
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メタバース可視化システムの活用例と

利用のメリット

運用者

利用者
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メタバース可視化システムは、NVIDIA Omniverse Enterpriseをベースとしたプラットフォームで、モデル編集、高速CGレンダリング処
理、可視化データベースの機能を有するシステムです。可視化データを保存・共有するためのNucleusサーバと、高性能GPUワークス
テーションから構成されるシステムです。

メタバース可視化システムの概要と導入効果

➢ 多くのシミュレーションデータのファイル形式をサポートしているParaViewでポスト処理可能な可視化データ（解析
データ）を 可視化評価にあわせてParaview Connector経由でデータ細分化し、大幅にデータサイズ削減する事で複
数の方とインターネット経由でNucleusによりデータ共有し、データ編集や 分析・評価（Kit Base Editor）することが
可能。

➢ ParaViewによる標準的な可視化（コンター、流線、等値面等）処理だけでは理解が深まらない仮想現実空間をKit 

Base Editorで質感やモーション設定し、RTX GPUを活用して高速にレンダリングすることが可能です。

➢ 学内研究員のワークステーションに高性能なGPUが搭載されていない場合でも、Windowsリモートデスクトップ接続
でRTX GPU搭載ワークステーションに接続しレンダリング処理することで可視化業務効率が向上します。

➢ CAEデータ以外のデザインCAD、BIMデータ等も同様に豊富なConnectorモジュールを利用する事でプラットフォー
ム環境を実現できます。

運用者

利用者
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• Omniverse Enterprise Nucleus Serverは、学内外の利用者を想定し、ライブ編集機能や多くのコンカレントユーザ
環境を実現します。

Omniverse Enterprise Nucleus Serverによる可視化データの共同利用

利用者A 利用者B 利用者A 利用者B

USD

ライブ編集機能
同じUSDデータに対して、同一セッションで、編集を行う機能

同時利用数
8名（MAX）

USDUSD

同時利用数
500名（MAX）

コンカレントユーザ
同一セッションに関わらず、アップロードとダウンロードを同時に行っているユーザ
ログインIDでの管理の為、1人のユーザーが複数のアプリケーションを同時に開いても、
1人の同時使用ユーザーとしてカウントされます

運用者

利用者
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ParaView

5.12.1

CAE各種ソルバ
構造/流体/化学/素材

/MD他

Omniverse-
Paraview

Connector
5.12

Kit Base Editor

可視化対象データ
等値面
コンター
流線 他

Omniverse
Nucleus

CG/BIM
3dsMax
Unity

UnrealEngine

Autodesk 3dsMax 
Connector

Unreal Engine
Connector

Unity
Connector 

USDファイル

Omniverse利用想定イメージ

Plugin

※

※

AVS/Express 8.5.1 UCD

※

※弊社サポート対象外
またConnectorモジュールはOmniverse Enterpriseサポート対象外

※

※

運用者

利用者
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ParaView 5.12.1でサポートされている拡張子リスト

・File -> OpenメニューでSupported Typesに記載のあるFiles of type

ParaView入力フォーマット一覧（1/4）
運用者

利用者
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ParaView 5.12.1でサポートされている拡張子リスト

・File -> OpenメニューでSupported Typesに記載のあるFiles of type

ParaView入力フォーマット一覧（2/4）
運用者

利用者
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ParaView 5.12.1でサポートされている拡張子リスト

・File -> OpenメニューでSupported Typesに記載のあるFiles of type

ParaView入力フォーマット一覧（3/4）
運用者

利用者
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ParaView 5.12.1でサポートされている拡張子リスト

・File -> OpenメニューでSupported Typesに記載のあるFiles of type

ParaView入力フォーマット一覧（4/4）
運用者

利用者
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Omniverse接続アプリケーション

複数のやりとりの方法 - 多くはリアルタイムに接続出来て、マテリアルの自動変換も可能

注）最新情報はNVIDIA WEBサイト（ https://docs.omniverse.nvidia.com/connect/latest/catalog.html ）で確認要
ただしConnectorモジュールはOmniverse Enterpriseサポート対象外

運用者

利用者
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導入効果（データ削減→軽量化）

➢ RTX GPU環境のUSD Composerで一般的な解析結果可視化処理（フォトレンダリング無）でも
3次元レスポンス（回転、拡大、移動等）がスムーズで、特に大規模CFDの非定常解析結果を連
続再生しながらインタラクティブに視点を変えることが可能です。

可視化ツール 合計データサイズ
RTX4000付 GPU WS
操作レスポンス

差異

ParaView 5.11 
（等値面を可視化）

約140GB △

・ステップ毎の結果を連続再生すると、等値面の
メッシュ生成やコンターの生成をステップ毎に行
うため、インタラクティブに視点を変えることが
難しい。
・コンター表示主体。

Omniverse Create 2022.3.3
（上記ParaViewからOmniverse Paraview-
Connector経由でUSDファイルに変換）

約数GB ◎
・解析結果の連続再生中もインタラクティブに視
点を変えるのがスムーズ。
・仮想現実空間評価する為のフォトレンダリング
（例：レイトレーシング処理）がスムーズ。

例：OpenFOAM 撹拌解析 https://www.youtube.com/watch?v=YESTQKdrD5E

（接点数262,701、格子数: 250,000、界面数: 762,500、内部界面数: 737,500、300ステップ出力）

運用者

利用者
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https://www.youtube.com/watch?v=YESTQKdrD5E
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➢ 比較ポイント
➢ 【Paraview】1フレームごとにメッシュ生成などの処理が発生し視点・回転・移動変換時の遅延が発生
➢ 【Omniverse】データ軽量化とGPU活用によるレスポンス

OpenFOAM 撹拌解析
（接点数262,701、格子数: 250,000、界面数: 762,500、内部界面数: 737,500、300ステップ出力）

ParaView Omniverse Create

タイムステップ毎にメッシュ生成などの処理 完成したメッシュデータの読み込みのみ

導入効果（データ削減→軽量化）
運用者

利用者
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液体タンクに空気を通過させながら撹拌したシミュレーションの結果

ParaView USD Presenter

   回転軸
ブレード

↓
メタル質感

気泡
  ↓

気体質感

コンター
     ベクトル
    同時表示

運用者

利用者
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導入効果（OpenFOAM解析結果のフォトリアルレンダリング事例）

https://www.youtube.com/watch?v=YESTQKdrD5E

https://www.youtube.com/watch?v=YESTQKdrD5E


© Prometech Software, Inc.

OMNIVERSE
USD Composer

１．モデルデータをシーンに追加
２．環境光、カメラ等を設定
３．オブジェクトにマテリアルを設定

⇒ 短時間でセットアップが可能

導入効果（CAEデータ→仮想現実空間）

ParaViewから変換したParticleworksの解析結果データ

フロントガラスに水が流れるシミュレーション結果

弊社Particleworksによる解析

解析結果を実際の環境に取り込んだデータ

運用者

利用者
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Omniverseは高品質リアルタイムレンダラを備えたプラットフォーム

⇒ 高品質なビューワや高速レンダラーとして使用可能

導入効果（USD Presenterによるリアルタイムレイトレーシング）

USD Composerによる編集 USD Presenterによる高速レンダリング (動画化)

フロントガラスに水が流れるシミュレーション結果

弊社Particleworksによる解析

運用者

利用者
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メタバース可視化システムの利用準備

利用者
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メタバース可視化システムの利用希望者は、大阪大学D3センターに相談し、
Nucleusサーバのアカウント発行を依頼してください

Omniverseを利用するためのRTX GPU搭載計算機を用意します
メタバース可視化システム内で利用可能なRTX GPU搭載ワークステーションもあります

メタバース可視化システムのNucleusサーバにアクセスする際に必要なCA証明書をイン
ストールします

1. メタバース可視化システム利用依頼

2. RTX GPU搭載計算機の用意

3. CA証明書のインストール

4. ParaViewのインストール ※1

5. Kit Base Editorのインストール ※1

6. ParaViewコネクタのインストール ※1

7. 利用開始

Omniverse ParaViewコネクタが対応するバージョンのParaViewをインストールします
ParaViewのバージョンは 5.12.1 を推奨します

Kit Base Editorをインストールします

ParaViewコネクタをインストールします

準備は完了です
利用を開始してください

利用者

33

※1 メタバース可視化システム内のRTX GPU搭載Windowsワークステーションを利用する場合は作業不要です

メタバース可視化システムの利用準備フロー
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1. メタバース可視化システム利用依頼

利用者
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メタバース可視化システムの利用希望者は大阪大学D3センターに相談し、以下の情報を入手して
ください

利用者

RTX GPU搭載計算機をご自身で用意する場合は、Kit Base Editorをダウンロードする際にNVIDIA
NGCアカウントでログインする必要があります。別途アカウントを取得してください
メタバース可視化システムのRTX GPU搭載Windows ワークステーションを利用する場合はNVIDIA 
NGCアカウントは不要です

35

メタバース可視化システムの利用時に必要な情報

種別 必要な情報

メタバース可視化システム
Nucleusサーバ

接続先ホスト名

Nucleus接続用アカウント および パスワード

メタバース可視化システム
RTX GPU搭載Windowsワークステーション
（利用する方のみ）

接続先ホスト名

リモートデスクトップ接続用アカウント および パスワード
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2. RTX GPU搭載計算機の用意

利用者

36
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Omniverseを利用する場合、RTX GPUを搭載した計算機が必要です
下記の表のマシンスペックが推奨されています
なお、メタバース可視化システム内にもRTX GPU搭載のワークステーションがあります

上記の表は2024年2月時点の情報です。最新情報は以下をご確認ください

https://www.nvidia.com/ja-jp/omniverse/platform/enterprise-systems/

利用者

37

Omniverse利用に必要なマシンのスペック
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3. CA証明書のインストール

利用者

38
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メタバース可視化システムのNucleusのアクセスにはHTTPS

による暗号化通信を利用しています。Nucleusに対する暗

号化通信を行うには、RTX GPU搭載計算機にCA証明

書をインストールする必要があります。NII Open 

Domain CA – G7 RSA の CA証明書を国立情報学

研究所のリポジトリからダウンロードしてください。

① 国立情報学研究所リポジトリにアクセスします

https://repo1.secomtrust.net/sppca/nii/odca4

/index.html

② サーバー証明書 RSA認証局の証明書のPEMをクリック

し証明書ファイルをダウンロードします。

国立情報学研究所リポジトリから証明書ダウンロード

CA証明書のインストール（1/9）
利用者

2

1

39
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① Windowsの検索欄に「ユーザー証明書の管理」と入

力します。

②「ユーザー証明書の管理」をクリックし、certmgr を開き

ます。

「ユーザー証明書の管理」を表示

CA証明書のインストール（2/9）
利用者

2

1

40
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① 「信頼されたルート証明機関 > 証明書」を右クリックし、

「すべてのタスク（K）>インポート(I)」をクリックします。

証明書インポート

CA証明書のインストール（3/9）
利用者

1

41
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① 証明書のインポートウィザードが開きます。「次へ」をクリッ

クします。

証明書インポート

CA証明書のインストール（4/9）
利用者

1

42
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① 「参照」をクリックしインポートする証明書を選

択します。

証明書インポート

CA証明書のインストール（5/9）
利用者

1

43
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① ダウンロードした NII Open Domain CA – G7 RSAの

CA証明書（ファイル名：nii-odca4g7rsa.cer）を選択

し、「次へ」をクリックします。

証明書インポート

CA証明書のインストール（6/9）
利用者

1

44
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① 証明書のインポートウィザードの完了と表示され

ます。完了(F)をクリックします。

証明書インポート

CA証明書のインストール（7/9）
利用者

1

45
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① セキュリティ警告が表示されますが、問題なけれ

ば「はい(Y)」をクリックします。

② 正しくインポートされたことが表示されます。OK

をクリックします。

証明書インポート

CA証明書のインストール（8/9）
利用者

1

2

46
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① 「NII Open Domain CA – G7 RSA」が信頼されたルー

ト証明機関に追加されていることを確認し、完了

です。

証明書インポート

CA証明書のインストール（9/9）
利用者

1

47
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4. ParaViewのインストール

利用者

48
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①Webブラウザで ParaViewダウンロードサイト

（https://www.paraview.org/download/）にア

クセスします。

②Omniverseに対応している ParaView 5.12.1 のイ

ンストーラ (.msiファイル）をダウンロードします。

ParaViewインストーラのダウンロード

1

2

ParaViewのインストール（1/7）
利用者

49
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①Nextをクリックします。

ParaViewインストーラの起動

1

2

ParaViewのインストール（2/7）
利用者

50
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①License Agreementに同意するにチェックし、Nextを

クリックします

ParaViewエンドユーザライセンスアグリメント

1

2

ParaViewのインストール（3/7）
利用者

51
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①インストールパスを変更しない場合はそのままNextをク

リックします。

ParaViewインストールフォルダ

1

2

ParaViewのインストール（4/7）
利用者

52
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①Installをクリックします。

ParaViewインストール準備

1

2

ParaViewのインストール（5/7）
利用者

53
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①インストール開始後、完了まで待ちます。

ParaViewインストール

1

2

ParaViewのインストール（6/7）
利用者

54
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①インストール完了後、Finishをクリックします。

ParaViewインストール完了

1

2

ParaViewのインストール（7/7）
利用者

55
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5. Kit Base Editorのインストール

利用者

56



© Prometech Software, Inc.

①Webブラウザで NVIDIA NGCサイト

（https://catalog.ngc.nvidia.com/orgs/nvidia

/teams/omniverse/resources/kit-sdk-

windows/files）にアクセスします。

②NGCサイトが表示されます。File Browserタブから 

Windows用Kit Base Editorをダウンロードします。

Actions の3点リーダーをクリックし、 Download Fileを

選択します。

ダウンロードにはNGCアカウントでログインする必要がありま

す。NGCアカウントを持っていない場合はアカウントを取得

してください。

Kit Base Editorのダウンロード

1

2

Kit Base Editorのインストール（1/5）
利用者

57
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① Kit Base Editorはzipで圧縮されているため、解凍し

ます。ここではデスクトップでzipファイルを解凍する例で説

明します。kit-sdk-public～.zipを選択し、右クリックから

すべて展開を選択します。

② 展開先を確認し、展開をクリックします。

Kit Base Editor zipファイル解凍

1

2

Kit Base Editorのインストール（2/5）
利用者

58

2
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① omni.app.editor.base.bat を実行します。

Kit Base Editorの起動

1

Kit Base Editorのインストール（3/5）
利用者

59
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①詳細情報をクリックします。

②実行をクリックします。

Microsoft Defender SmartScreenによる保護画面

1

Kit Base Editorのインストール（4/5）
利用者

2

60
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左の画面のようにKit Base Editorが起動すればインス

トール完了です。

Windowsの環境によって、特にNVIDIAのGPUドライバ

のバージョンによっては、エラーで起動しない場合があります。

その場合はKit Base Editorの他のバージョンを試してく

ださい。

Kit Base Editorトップ画面

Kit Base Editorのインストール（5/5）
利用者

61
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6. ParaViewコネクタのインストール

利用者

62
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①Webブラウザで ParaView Connector のインストール

手順方法が記載されたサイト

（https://docs.omniverse.nvidia.com/connect

/latest/paraview/install.html）にアクセスします。

②ParaView Connectorの 5.12.1のプラグイン (Zip

ファイル）をダウンロードします。

ParaViewコネクタのダウンロード

1

2

ParaViewコネクタのインストール（1/8）
利用者

63
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①任意の場所にダウンロードしたZipファイルを置き、Zipファ

イルを選択し右クリックします。

②すべて展開をクリックします。

③展開先を確認し、展開をクリックします。

ParaViewコネクタの展開

1

2

ParaViewコネクタのインストール（2/8）
利用者

3

64
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①ParaViewOmniSetup.bat をダブルクリックします。

ParaViewコネクタのセットアップスクリプトの実行

1

ParaViewコネクタのインストール（3/8）
利用者

65
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①詳細情報をクリックします。

②実行をクリックします。

Microsoft Defender SmartScreenによる保護画面

1

ParaViewコネクタのインストール（4/8）
利用者

2

66
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①はいをクリックします。

②ParaViewのインストールフォルダを選択し、OKをクリック

します。

ParaViewのインストールフォルダの指定

1

ParaViewコネクタのインストール（5/8）
利用者

2

67
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①ライセンスアグリメントを確認します

②I Agreeをクリックします

ParaViewコネクタのライセンスアグリメント

1

ParaViewコネクタのインストール（6/8）
利用者

2

68
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① ParaViewコネクタをインストールします。Installをクリッ

クします

② インストール状況を確認します。ParaViewコネクタの

Install Statusを確認します。

③ Closeをクリックします。

ParaViewコネクタのインストール状況

1

ParaViewコネクタのインストール（7/8）
利用者

2
3

69
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①ParaViewコネクタがインストールされると、

Omniverseツールバーが表示されます。

②表示されない場合は、 View > Toolbars > 

OmniverseConnectorのオプションを有効にし

てください。

ParaViewコネクタプラグインの確認

1

ParaViewコネクタのインストール（8/8）
利用者

2

70
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7. 利用開始

利用者

71
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メタバース可視化システムの利用方法

利用者

72
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RTX GPU搭載Windowsワークステーションの
リモートデスクトップ接続

利用者

73
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RTX GPU搭載Windows ワークステーションへのリモートアクセス

SSD 1TB

学内利用者用GPU-WS

OS: Windows 11
CPU: 16コア
メモリ: 128GB

SSD : 1TB
HDD : 4TB
GPU : RTX 6000 ada x 1

貴学マシンルーム

Cユーザ利用中Bユーザ（接続要求）Aユーザ（接続要求）

接続要求が届くとCユーザの画面で
接続許可/拒否を選択することが可能。
なお、一定時間経過して応答なしの場合

は接続許可したものとみなされる。

×
Cユーザが拒否

〇
Cユーザが許可

一定時間経過しても応答なし
HDD 4TB

Cドライブ

リモートデスクトップ画面

Dドライブ

RTX GPU搭載Windowsワークステーションはリモートデスクトップでアクセスし、利用することが可能です。

運用者

74

利用者
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①Windowsボタンを右クリックし、ファイル名を指定して実

行 をクリックします。

②名前に mstsc を入力し、 OKをクリックします。

リモートデスクトップ接続画面の起動

1

Windowsリモートデスクトップ接続（1/2）
利用者

75

2
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①コンピュータにRTX GPU搭載Windowsワークステーショ

ンの接続ホスト名を入力し、「接続」をクリックします。リモー

トデスクトップ接続用アカウント および パスワード を入力し

ログインしてください。

リモートデスクトップ接続

1

Windowsリモートデスクトップ接続（2/2）
利用者

76
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Nucleusへのアクセス方法

利用者

77
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Nucleus Navigator

WebブラウザからNucleus Navigatorを使用すると、メタバース可視化システムのNucleusに保存されているデータ

を簡単に参照することができます。ユーザ認証後、Nucleus のコンテンツが表示されます。その後、権限の管理、コン

テンツのアップロードやダウンロード、他のユーザにコンテンツを紹介するための URL の共有など、さまざまな機能

を簡単に利用できます。

78

利用者
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①Webブラウザで Nucleus Navigator （https://メタ

バース可視化システムNucleusサーバ接続ホスト名

/omni/web3/）にアクセスします。ここでは、Nucleus

サーバ接続ホスト名がserver.sample-u.ac.jp の場合

を例にしています。

②左側のツリー画面から接続するNucleusサーバをクリック

します。

③ログイン画面が表示されたら、Nucleus接続用アカウント、

パスワードを入力し、LOG IN をクリックします。

Nucleus Navigatorへのアクセス および ログイン

Nucleus への アクセス（1/3）

1

2

3

利用者
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①Nucleusに接続すると、左側のファイ

ルツリーでNucleusに格納されたデー

タを確認することができます。

②Usersフォルダのユーザフォルダ配下

にユーザ自身が作成したデータが格納

されています。

Nucleusに格納されたデータ確認

Nucleus への アクセス（2/3）

1

2

利用者
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①Nucleusに格納されたファイル あるいは フォ

ルダをクリックします。

②Permissionsタブで選択したファイル 

あるいは フォルダの権限を確認するこ

とができます。admin権限を有する

ユーザはそのファイル あるいは フォ

ルダの権限を変更できます。ユーザやグ

ループに対する割当を追加可能です。

Nucleusに格納されたデータの権限情報の確認

Nucleus への アクセス（3/3）

1 2

利用者

81
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各権限で可能な操作

フォルダ内のファイルを表示する

ファイルの読み込み

フォルダに移動する

権限を参照する

フォルダにファイルを追加する

ファイルの内容を変更する

コピー

ファイルの移動

ファイルの名前を変更

ファイルの削除

権限の変更

82

利用者

運用者
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ParaViewコネクタの利用方法

利用者

83
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Omniverseで可視化するためにParaViewコネクタで

USDファイルに変換する方法を説明します。ここでは、

ParaViewのサンプル「ウェーブレット」(Sources > Data 

Objects > Wavelet)を例に説明します。

① ParaViewを起動します。

② ParaViewのサンプル「ウェーブレット」を読み込み、コン

ターの値を100, 150, 200にセットし、Applyします。

ParaViewの起動とサンプル「ウェーブレット」の読み込み

ParaViewコネクタの利用方法（1/9）
利用者

84
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Nucleusへの接続

ParaViewコネクタの利用方法（2/9）
利用者

85

1

2
3

① Omniverseツールバーの人型マークをクリックし、サイン

イン ダイアログを表示します。

② メタバース可視化システムのNucleusサーバーの接続

先ホスト名を入力し OK をクリックします。 

③ Nucleus接続用アカウント および パスワード を入力

し、LOGIN をクリックします。ログイン成功の画面が表示さ

れます。
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Omniverseコネクタ設定

ParaViewコネクタの利用方法（3/9）
利用者

86

2

1

3

Omniverseツールバーの設定画面で、USDファイルの出

力先やOmniverseアプリケーションのインストールパスを

指定することができます。

① Omniverseツールバーの歯車マークをクリックします。

② Connection InfoのProject DirectoryのBrowse

をクリックします。

③ Nucleusのデータフォルダが表示されます。USDファイル

の出力先を変更したい場合は変更してください。
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Omniverseコネクタ設定

ParaViewコネクタの利用方法（4/9）
利用者

87

① データフォルダが正しいことを確認します。

② Saveをクリックします。

2

1
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（参考）Omniverse Connector Settings
利用者

1

Omniverse Connector Settingsより、USDファイルを保存するディレクトリを設定できる他、
①でParaViewから起動可能なOmniverseアプリケーションを設定することもできます。
この設定は、Omniverse Connector ビューの作成時に適用され、既に起動済みのビューには反映されません。

88
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Omniverse Connectorビューの表示

ParaViewコネクタの利用方法（5/9）
利用者

89

1

2

3

① ParaViewのレイアウトタブから+をクリックします。

② Omniverse Connectorをクリックします。

③ Omniverse Connector Settingsが表示されます。

Createをクリックします。

ここで利用するOmniverse Connectorビューは、

NucleusサーバーにUSDファイルを出力するビューです。 

USDファイルに反映したくない場合は、代わりに別のビュー

を使用してください。
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USDファイルへの変換・反映

ParaViewコネクタの利用方法（6/9）
利用者

90

① Pipeline BrowserでUSDファイルに反映したいものを

可視化します。ParaViewで可視化したデータがUSDに

自動的に変換されます。

② この例では1フレームのみですが、時系列データなど複数

フレームのデータがある場合は再生ボタンをクリックすると、

複数フレームのデータがUSDに変換されます。

1

2
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Kit Base Editorの起動

ParaViewコネクタの利用方法（7/9）
利用者

91

① OmniverseツールバーのOpenView(紙飛行機マー

ク)のボタンをクリックすると、Omniverse Connector 

Settingsで設定されたOmniverseアプリケーション(Kit 

Base Editorなど)で開きます。

② Omniverseアプリケーションが起動したら、Nucleusの

データフォルダを表示させます。

1

2
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USDファイルの読み込み

ParaViewコネクタの利用方法（8/9）
利用者

92

① ユーザフォルダ配下の「Session_X」フォルダ配下を選

択します。

② FullScene.usdファイルをクリックします。

③ 現在のステージを保存するかメッセージが表示されます。

Don’t Save をクリックします。

1
2

3
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USDファイルの可視化

ParaViewコネクタの利用方法（9/9）
利用者

93

このように、ParaViewコネクタでUSDに変換したファイルを

Omniverseアプリケーションで可視化することができます。
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（参考）ライブ同期
利用者

①のライブ同期のボタンを押すと、Nucleusサーバーに特別なレイヤー（live_FullScene.live）が作成されます。
OmniverseアプリケーションでParaViewパイプラインの変更が自動的に反映されます。
ただし、利用する場合はLIVE MODE CONTROL WIDGET Extensionをインストール・ロードしておく必要があります。

94

1
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USD Compser および

Kit Base Editor の利用方法

利用者

95
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利用者

96

USD Composer および Kit Base Editorトップ画面（基本）

オブジェクトに対する操作

（選択、移動、回転、拡大など）

各種ブラウザ（コンテンツなど）
プロパティ設定

ステージ、レンダリング設定
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利用者

モデル

星を中心とした軌道の移動
+カメラ目線は星に向くような
回転
※星の位置はモデルの中心とは違う

光源 モデルの色付けに必要
(現実のように、「モデルに光が反射してカメラに届く」
を再現しているので光源が無いと何も見えない)

97

カメラ（視線）

カメラについて（1/4）
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利用者

モデル

光源 モデルの色付けに必要
(現実のように、「モデルに光が反射してカメラに届く」
を再現しているので光源が無いと何も見えない)

カメラ（視線）

平行移動
視線方向ベクトルに垂直な方向への平行移動

98

カメラについて（2/4）
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利用者

モデル

光源 モデルの色付けに必要
(現実のように、「モデルに光が反射してカメラに届く」
を再現しているので光源が無いと何も見えない)

カメラ（視線）

カメラのlocal座標系での回転
視線方向ベクトルが回転する

99

カメラについて（3/4）



© Prometech Software, Inc.

利用者

モデル

光源 モデルの色付けに必要
(現実のように、「モデルに光が反射してカメラに届く」
を再現しているので光源が無いと何も見えない)

カメラ（視線）

100

スケール
視線方向ベクトルを軸
とした平行移動

カメラについて（4/4）
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利用者

①画面右上の情報の on/off
②cameraの perspective/ top / front / right
Top: y軸正から負に見下ろす
Front: z軸正から負に見下ろす
Right: x軸正から負に見下ろす
※左下の軸表記をみるとわかりやすい

③カメラ移動
1. 軌道運動 (Alt + 左クリック)
2. 平行移動(右クリック + 左クリック)
3. 視点の回転(左クリック)
4. スケール(Alt + 左クリック or マウスホイール)

④Top/ front/ rightでは、
平行移動とスケールのみに対応

キーボード操作は以下を参照

https://docs.omniverse.nvidia.com/extensions/latest/common/keyboard_shortcuts.html?highlight=Alt#viewport-controls

101

基本操作
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利用者

カメラ（Viewの視点）から光を出す

102

ライトについて（1/4）
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利用者

Stage Lights

Connectorでデータ移行したときに
デフォルトであるlight Primを利用する

ステージの詳細は以下を参照

https://docs.omniverse.nvidia.com/extensions/latest/ext_core/ext_stage.html#stage

103

ライトについて（2/4）
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利用者

Primを選択
（左図だと平行光源）
すると、Propertyに情報
がでる

左図は光源を
選択しているので

光源の位置・向き(Transform)
光源の色(Light -> Main)
などを設定できる

104

ライトについて（3/4）
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利用者

光源の位置・向き(Transform)
を変えたとき

Y軸を回転軸として回転させる
（Rotateは弧度法）

Propertyの値を変えるには

①数字のボックスを
左クリック + マウスドラッグ
で連続的に変更する

②数字のボックスを
左ダブルクリック
で指定した数字を入れる

①は動画の前半、②は動画の後半

数字のボックスの右に出る青いのは
右クリックすると初期値に戻る

太陽から出ている黄色い線は
光の進行方向。

105

ライトについて（4/4）
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Kit Base Editor や USD Composer を効果的に利用

するにはExtensionを組み込むことが重要です。

ただし、Core ExtensionのみOmniverse Enterprise

サポート対象です。サポート対象のExtensionや廃止

（非推奨）のExtensionの一覧は以下を参考にしてく

ださい。

https://docs.omniverse.nvidia.com/kit/docs/

kit-manual/109.0.3/guide/kit_exts.html

(Kit Base Editorの場合) 

① Windowメニューから Extensionsを選択します。

(USD Composerの場合) 

① Developerメニューから Extensionsを選択します。

Extensionsメニューの起動

Extensionの利用方法（1/5）

106

利用者

1 1
Kit Base Editor USD Composer
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① 組み込みたいExtensionを検索します。

② 組み込みたいExtensionを選択します。ここでは

ParaViewコネクタのライブ同期機能に利用するLIVE 

MODE CONTROL WIDGETを選択します。なお、

USD ComposerはデフォルトでLIVE MODE 

CONTROL WIDGETはインストールされています。

組み込むExtensionの検索

Extensionの利用方法（2/5）
利用者

107

1

2
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① Extensionをインストールします。INSTALLをクリックし

ます。

Extensionのインストール

Extensionの利用方法（3/5）
利用者

108

1
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① Extensionを有効化します。

② Kit Base Editor や USD Composer を起動時に

自動で組み込みたい場合はAUTOLOADにチェックします。

Extensionの有効化

Extensionの利用方法（4/5）
利用者

109

1 2
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① EnvironmentやMaterialなどブラウザ機能を組み込

んだ場合はWindowメニューのBrowsersから表示したい

ブラウザを選択してください。

Extensionで組み込んだブラウザ機能の表示

Extensionの利用方法（5/5）
利用者

110

1
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利用者

111

コンテンツブラウザ

コンテンツブラウザからUSDファイルを直接指定し開くことができます。
ただし、チェックポイントの表示・利用については、VERSIONING WIDGETS Extensionのインストール・
ロードが必要です。
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利用者

112

ファイルの変更履歴

Omniverseにおけるファイルの変更履歴の機能はNucleusによって提供されます。
ファイルの変更履歴は以下から構成されます。チェックポイントは特定の時点でのファイル内容を表
し、作成後の変更はできません。ブランチによる変更履歴は、「デフォルトブランチ」と呼ばれる1
つのブランチのみサポートされています。

用語 意味 編集可否

ブランチ ファイルの別バージョン 可

ヘッドリビジョン ブランチ上のファイルの最新バージョン 可

チェックポイント ファイルのバージョン履歴 否

チェックポイントは、ファイルの作成、保存、アップロード、
コピー等が行われると作成されます。ファイル保存の際には
チェックポイントにコメントを記載することができます。

ライブ同期モードではチェックポイントは自動的に作成されず、
ヘッドリビジョンファイルのみが更新されます。ライブ同期を
開始する前にファイルを保存することを推奨します。



© Prometech Software, Inc.

利用者

113

チェックポイントの復元

コンテンツブラウザには選択したファイルのチェックポイントが表示されます。チェックポイント
を復元する場合は復元したいチェックポイントを選択し「Restore Checkpoint」をクリックします。
チェックポイントを復元すると、チェックポイントが作成されます。リストの一番上の項目は、
ファイルの最新バージョン （ヘッドリビジョン）であり、チェックポイントではありません。

復元したチェックポイントに対する
チェックポイントが作成される

ヘッドリビジョン
への反映
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利用者

114

ビューポート、ステージペイン、レイヤーペインへの反映

選択したファイルのチェックポイントリストから、ビューポート、ステージ ペイン、およびレイ
ヤー ペインにドラッグ・アンド・ドロップし反映することができます。

選択したファイルのチェックポイント
がリストされます
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利用者

115

Environmentブラウザ

Environmentブラウザで簡単に背景を設定することができます。
ただし、Kit Base Editorで利用する場合は、ENVIRONMENT WINDOW Extensionのインストール・ロードが
必要です。



© Prometech Software, Inc.

利用者

116

マテリアルブラウザ

マテリアルブラウザから新しいマテリアルを適用し質感を与えることができます。
ただし、Kit Base Editorで利用する場合は、MATERIAL BROWSER Extensionのインストール・ロードが
必要です。
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ONIONへのバックアップ

利用者

117
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ONIONのアカウント・アクセスキーを取得することで、 Omniverseのユーザーデータをバックアップしデータを保存しておくことができます。

① 以下の手順でONIONのアクセスキーを取得します。

https://www.hpc.cmc.osaka-u.ac.jp/system/manual/onion-use/first-step#key

② RTX GPU搭載Windowsワークステーションで、PowerShellを起動し、以下のコマンドでAWS CLIの初期設定を行います。 

aws configure --profile=[profie name]

AWS Access Key ID [None]: (事前に取得したアクセスキーを入力してください)

AWS Secret Access Key [None]: (事前に取得したシークレットキーを入力してください)

Default region name [None]: osakau

Default output format [None]:（設定不要です。空欄のままEnterキーを押してください）

RTX GPU搭載WindowsワークステーションにはAWS CLIがインストールされていますが、他の計算機でONIONと連携したい場合は以下を参考にAWS CLIを

インストールしてください。

https://docs.aws.amazon.com/ja_jp/cli/latest/userguide/cli-chap-install.html

AWS CLIの初期設定

ONIONへのバックアップ方法（1/3）

118

利用者
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OmniverseデータをRTX GPU搭載Windowsワークス

テーションでダウンロードします。

③ USD ComposerあるいはKit Base Editorのコンテ

ンツブラウザで、バックアップしたいOmniverseデータフォル

ダを選択し、右クリックして「Download」を選択します。

④ 保存したい場所を選択し、「Save」をクリックします。指

定した場所にOmniverseデータを含むフォルダが作成さ

れます。

Omniverseデータのダウンロード

ONIONへのバックアップ方法（2/3）

119

利用者

３

４
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⑤ 以下のコマンドで、新規バケットを作成します。

aws --endpoint-url=https://s3-osakau.oniongw.onion.osaka-u.ac.jp s3 mb s3://[作成するバケット名]

⑥ バックアップしたいフォルダが保存された場所に移動し、指定したフォルダ内の全てのファイルに対してコピーコマンドを実行します。

cd C:¥Users¥testuser¥Desktop¥

aws --endpoint-url=https://s3-osakau.oniongw.onion.osaka-u.ac.jp s3 cp [バックアップしたいフォルダ名] s3://[作成したバケット名] /[バック

アップフォルダ名] –recursive

⑦ バックアップ先のオブジェクト一覧を表示し、コピーできていることを確認します。

aws --endpoint-url=https://s3-osakau.oniongw.onion.osaka-u.ac.jp s3 ls s3://[作成したバケット名] /[バックアップフォルダ名]

ONIONへのコピー

ONIONへのバックアップ方法（3/3）

120

利用者
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Omniverse可視化ワークフロー例

利用者

121

運用者
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ユースケース１：OpenFOAMの撹拌槽シミュレーション

ParaViewでの

データ読み込み

ParaView Connector

でのUSDファイル変換

Kit Base Editorでの

マテリアル追加

Kit Base Editorでの

可視化

運用者

利用者

122

* 動画では旧製品のUSD Composerが使用されていますが、現在のUSD ComposerやKit Base Editorでも操作フローに変更はありません。
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ユースケース２：AVS/Expressの車両ハーフモデル（旧型式UCD）

ParaViewでの

データ読み込み

ParaView Connector

でのUSDファイル変換

Kit Base Editorでの

可視化

運用者

利用者
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* 動画では旧製品のUSD Composerが使用されていますが、現在のUSD ComposerやKit Base Editorでも操作フローに変更はありません。
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ユースケース３：AVS/Expressのキャビテーション乱流（Field形式）

ParaViewでの

データ読み込み

ParaView Connector

でのUSDファイル変換

Kit Base Editorでの

可視化

運用者

利用者

124

AVSのField形式は
UCD形式に変換する
必要あり

* 動画では旧製品のUSD Composerが使用されていますが、現在のUSD ComposerやKit Base Editorでも操作フローに変更はありません。
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利用者

125

Omniverseを活用した複数名でのコラボレーションのメリット

高解像度で大規模なシミュレーションデータを複数名で評価・議論する場合、
・「データで共有する」ではなく、 Webミーティングなどで「画像で共有する」
・計算条件の異なるデータや時系列データを多数の画像や動画に変換し共有する
・大容量のシミュレーションデータをそのままのデータで直接渡して共有する
といったことがなくなり、
Omniverseプラットフォーム上で、計算条件の異なるデータ・時系列データを軽量化したUSDファイルを扱うことで、
インタラクティブに評価・議論する、フォトリアルな可視化表現にアレンジするといった、
より高度な「3次元データコラボレーション」が可能となり、科学的現象の理解が深まります。

共同研究者（実施者）

メタバース可視化システム
Nucleusサーバ

USD
USD

USD

変更履歴が保存された
複数の解析・可視化データ

可視化データ
保存

レビュー
ParaViewから
USDへの変換

高度な
可視化表現

共同研究者（レビュワー） シミュレーション研究者

可視化研究者

運用者
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